
Biorhythms   5.4c   - New Version!
Here is a list of the bug fixes and improvements that have made up each version of the 

program. I recommend that you replace your old version with the latest one, 5.4c.

Version   5.4c   (March 1996)  
• In the Multiple Comparison Setup window, you can now open any selection of charts by double clicking, and the handling of missing  

files or damaged entries has been improved.
• Fixed bug with up/down controls in Multiple Comparison Results window.
• You can now drag and drop chart interpretations.
• Big (possibly) memory leak fixed in Multiple Comparison Setup window.
• Fixed a few visual problems with Drag and Drop, and you can now drop a file into the Schemes Editor to import its settings.
• Updated documentation and added CompuServe addresses.
• Fixed a three day old bug with the ‘Chart Summary’ list.
• Fixed an obscure bug when searching a chart: attempting to search beyond the point at which the person’s age exceeds 89.7 years would  

result in the search reverting to 5 years before their birth. Stupid mistake; gone now.
• Reorganised ‘Interpretations’ and fixed memory leak with ‘Chart Summary’.
• Fixed big memory leak in the list in the Chart Search window.
• Recompiled almost all the xDEFs, improved many, and killed flicker in colour palette menus.
• Biorhythms has been rebuilt using CodeWarrior 8.
• Aggregate cycle now introduced to chart windows – shows a sort of aggregate condition: the average of your physical, emotional and  

intellectual conditions.
• Biorhythms will no longer accidentally open charts on top of movable modal dialogs. Discovered that you can’t drag and drop aliases  

(not my fault).
• By enlarging the colour picker menus, and increasing the height of the ‘Search’ and ‘Schedule’ progress bars, I have made Biorhythms  

5.4c fully compatible with the shareware extension ‘Aaron’.
• You can now ‘Macintosh drag & drop’ pictures from the Images list and from Calendar windows, and drop chart documents into chart  

windows and the Favourite Menu editor.
• Printing a utility window (all except charts, calendars, comparisons, or Help) is improved – header is positioned properly, framed border  

is available, and long bits of text won’t overlap bits in other columns.
• New Options submenu in the Edit menu, now includes the ability to alter print margins and picture spacing.
• Slight improvement with ‘Help’. It  now supports Macintosh drag & drop – Apple's system extension is provided for those without 

System 7.5 or later – so you can now drop selections straight into any compatible program, such as SimpleText or the scrapbook.
• More major printing improvements – optional page borders, pictures can be aligned left, centre, or right on the page, and you can now  

choose a header font, size, and style for calendar printing, in addition to the style for general text. Radically improved Print Options dialog.
• DateCDEF updated to version 5.2 – will automatically adjust on Swedish systems (and possibly others), moving the year box to the left,  

and the date and month boxes to the right. Thus all possible date formats are now displayed in the correct local format.
• Printing a Biorhythms document from the Finder is now handled better.
• Fixed bug with age calculation in Multiple Comparison setup window.
• Fixed small bug with Chart Tools window.
• Fixed inconsistency with the Edit menu and Chart Comparison window and Date Calculator.
• You can now choose an action to be taken whenever the program is started: for example, show the Hint window or start a multiple  

comparison.
• ‘Handy Hints’ lets you see useful hints to improve your use of the program.
• ‘Macintosh Information’ moved to Special menu.
• Redesigned the bottom of the chart window – using proper controls with aesthetic highlighting.
• In addition to displaying the day labels at the bottom of chart images, you can now display months or years or both.
• Most windows now have a paler background than before, where possible.
• ‘Preferences’ dialog redesigned with a page icon list rather than popup menu.
• Fixed inconsistency with the Edit menu and eligible movable modal dialogs.
• Fixed bug with the magnifying glass cursor along the edge of the chart area.
• Chart durations: in addition to the standard chart durations of 30 days, 6 weeks, 33 days etc, you can now choose any duration between 2  

and 1000 days for any chart.
• Printing: you can now choose the font, size, and style with which printed text is drawn using the ‘Print Options…’ option in the Edit  

menu, or by clicking the ‘Options…’ button in the Print job dialog box.
• You can now copy the image from a Comparison window to the clipboard.
• Fixed a bug that could cause a crash when ‘Copy text’ is chosen when a Calendar window is active. It now successfully copies a text-

version of the calendar to the clipboard.
• Chart, Calendar, and Comparison windows are now printed out properly at last – combining formatted text and images and with a choice 



of font, size, and style. This really is a great improvement.

Version   5.3c   (December/January 1995/6)  
• Can now print Help window properly – actually prints out the full text, like a wordprocessor, rather than just the image of the Help  

window.
• Preferences (Extra Prefs page): fixed slight problems with ‘Use defaults’ and ‘Fastest’ buttons.
• Help window scrolling greatly improved.
• Mass Comparison renamed Multiple Comparison. New dialog gives you greater control over the charts to be compared, charts can be  

added or removed at any time rather than having to choose at one moment. Furthermore file lists can be saved and loaded saving you from 
having to add the same lot of charts time after time. Also information about the chosen charts can be viewed in the dialog box.

• File list LDEF improved, now able to display little document icons next to the name.
• Multiple Comparison window: if you choose ‘Compare’ with 3 or more charts in the list, a multiple comparison will take place, however  

if there are only 2 charts, the standard ‘Compare charts…’ window will be opened with the data from these two charts. Very intelligent!
• Double clicking a file list will intelligently open the Multiple Comparison window, open the list file and add the files stored inside to the  

list in the window. Clever.
• Chart and Special menus reorganised.
• Chart Tools window added – this acts like a floating palette allowing you to quickly change the colour, pattern or thickness of the  

physical, emotional and intellectual cycle lines using the popup boxes. Clicking the zoom box will alternate between the wide, square, and tall  
settings to minimise screen clutter.

• Fixed tiny problem with the ‘Cancel’ button in the Favourites Menu editor.
• All lists can now be navigated using the up and down cursor keys.

Version   5.2c   (October 1995)  
• Scheme Editor – for editing colour schemes which can be applied to chart images has been completely rewritten:

◊ Maximum number of editable schemes increases from 8 to 400.
◊ Greatly improved dialog box, with smart list allowing any number of schemes to be edited at once, not just one at a time.
◊ Schemes can be added or removed from the list at any time.

• Fixed minor problem when opening Preferences with the Texture file page open.
• The line width menus can now handle colour much better – and the control used in the popup line menu now highlights better.
• Mass Comparison: rather than just calculating the overall compatibility between each person and all the others, now the three constituent  

compatibilities – physical, emotional, and intellectual – are calculated, ranked, sorted and averaged as well, and can be saved as text reports.
• Event handling code radically improved and corrected, fixing problems with text fields and the Edit menu.
• New Chart dialog improved.
• You can now display the full title of an opened chart document as follows: ‘Macintosh HD:Folder: FileA’ rather than just ‘FileA’.
• Preferences: the second page has been greatly expanded, Full Titles can be turned on or off here and the Chart status display (the date and 

the conditions, which change as you move the magnifying glass cursor) can be customised with optional condition display, and a number of  
different date formats. Fixed a bug with the Preferences page.

• Changing the Condition Colours (Edit menu) will now automatically update all charts and calendar windows with the new colours.
• The main event handling code has been completely rewritten, replacing many disastrously crude and inefficient routines. You probably 

won’t have noticed, but the changes have made a vast difference.
• Apple Events are now used extensively for internal operations in order that Biorhythms can become scriptable (eventually).
• Toolbar greatly improved – quicker overall, better highlighting, improved icons.
• The Macintosh information window would look slightly wrong under System 7.5.
• More ‘intelligent’ Coloured Conditions drawing yields significant speed and efficiency improvements.
• Fixed a bug where unnamed textures wouldn’t show up in the Textures menu.
• Texture Info: now draws quicker with better multi-screen support. Fixed a bug whereby direct-mapped textures (16/32 bit) would be  

incorrectly described.
• Chart drawing: patterned lines used to be erroneously (but practically indistinguishably) drawn with light grey as the background colour,  

and not white as they should be.
• Colour Bar introduced, giving the advantages of the Coloured Conditions option, in a less obtrusive form.
• When choosing a texture file to use, the number of acceptable textures found within the file will be displayed.
• TextCDEF becomes version 4.0, handling colours and styles.
• Grouped Summary redesigned to resemble Chart Summary, also the list will no longer undergo an unnecessary redraw when the date  

menu is popped up but no option is chosen.
• When choosing an alternative texture file, an enhanced standard file dialog box is displayed, correctly highlighting the current texture  

file, fixing a bug that caused the incorrect directory to be displayed, and allowing you to monitor how many valid textures are contained in the  
files shown in the list. Only files containing usable textures will be shown in the list.

• Improved drawing of the chart key (line samples): quicker, uses less memory and looks better.
• More substantial internal changes – old sections rationalised, new popup menu to replace black&white popup box.
• Changing the date labels or line samples settings will now redraw all charts immediately, fixing a bug which had meant that if the front  

window wasn’t a chart, none of them would be redrawn.



• Scheme bug fixes – very minor – when no user schemes are present, corrupt initial data would be shown in the Editor, this is now  
replaced by the default settings. Also the separator after the ‘Random’ menu item is no longer displayed when there are no user schemes to go  
after it.

• Fixed a bug where double-clicking on a Help file that was not loaded when the program started up could cause a crash.
• Search: in 5.03c I introduced an option “that will stop you interrupting a search operation, but with the result that speed is increased by  

around 50-150%”. Well now, speed without the option on has been increased considerably such that the advantage may now only be 5-10%. So  
you may never need to use the option anyway.

• Printing: significant improvements all round.
• Fixed a bug which could occur when attempting to open an invalid chart file.
• All supplied charts are now in the new format.

Version   5.1c   (5th September 1995)  
• Chart interpretations can now be turned on or off, as you desire.
• Powerful new toolbar with easy access to file management functions, and various chart tools and options.
• Moderate menu reorganisation.
• Improved Help interface.
• Can now save individual help pages, in a more simple way, and can save style information for SimpleText files.
• Toolbar handling improved.
• Stupid problems that could affect background windows when inactive control highlighting was turned off have been eradicated.
• Changing condition colours will now update an open calendar window (as well as chart windows).
• Fixed bug when choosing to use no background or grid in Schemes editor window.
• Updating the Grouped Summary will now cause an animated cursor to appear.
• Double-clicking a chart entry in the Grouped Summary will now select that window.
• Fixed stupid bug whereby growing the Help window interfered with other windows.
• You can now copy the settings from one chart and apply them to another.
• Fixed tiny inconsistency with unnecessary calendar window updating.
• Printing improvements.
• Improved multiple monitor handling.
• More control over windows – can now tile and stack chart windows, and zoom them using a menu option.
• Extensive (and essential) structural changes to chart data management made tiling/stacking possible, and may allow me to restore the  

gone but not forgotten ‘synchro’ feature. †
• EvenBetterBusError revealed two dangerous bugs: PrValidate used with no open printer driver was found to cause startup errors (and  

possible crashes); and there was another one too.
• DateCDEF raised to version 5.0.1 with a smart 3D look for any monitor capable of 256 colours or greater. Great.
• The three MDEFs now pop up much more safely – especially in the absence of Color QuickDraw, and they flicker much less.
• Fixed a drawing code mistake and killed the extra chart image redraw that had disguised it for so long. A great improvement.
• DateCDEF updated to 5.0.2 which reduces flicker when drawing the 3D effects.
• The palette at the bottom of the chart windows has been altered slightly, but now looks much better.
• The Cycles menu works more ‘intelligently’, eliminating unnecessary updates, especially with the pan-cycle submenus (at the bottom).
• Using the date picker controls or moving items in the Fave Menu editor used to bomb when used with EvenBetterBusError. No more! I 

have fixed the stupid errors, and a number of other possible ‘writes to nil’. Great!
• Chart Summary now looks slightly more sophisticated, with a redesigned LDEF.
• A dangerous crash that would frequently beset Mass Comparison has been solved, much to my relief.
• Synchronised scrolling is back, based upon the synchronisation concept used in HyperCard and BBEdit.
• Memory fragmentation reduced.
• Rewrote the LDEF that handles the Chart Summary list, creating version 2.2. As a result, memory efficiency increased, and unnecessary  

redrawing was reduced.
• Fixed a couple of minor bugs whereby synchro-scrolling a chart with phase indicators on, or subsequently altering chart duration could 

mess up chart drawing. Also fixed a problem with transfer modes. All three bugs appeared during the upheaval caused by † above, but are now 
fixed.

• When Mass Comparison examines a file, the name that will be used in the results dialog (and report file) will no longer be the name of  
the chart file, but the name of the person whose data is stored within (usually the same). It is better like this.

• There is a new page in the Preference dialog, containing two new options. The first offers to sort all the charts you choose for a Mass  
Comparison by name, rather than the order in which they were chosen. The fast exchange sort can sort 110 charts in a fraction of a second! You 
can also turn Synchro Scrolling on or off from here, as well as from the Windows menu.

• Charts folder reorganised.
• Fixed a bug that could mean clicking in the toolbar at the bottom of a chart would have no effect.
• Significant  Preference  improvements  –  clicking  in  the  date  label  on/off  tool  at  the  bottom of  a  chart  will  update  all  open  charts 

accordingly. Date label styles (a day highlighted in red) can now be turned off, or altered. Other improvements, including: last Preference page 
remembered.

• Fixed a bug whereby Synchro Scrolling would cause Chart Summary to display, for a split second, each chart’s summary in turn, rather  
than that of the front chart.

• Program now uses greatly superior animated cursor routines.
• Reduced the time taken to open chart files.



• Drawing textures, backgrounds, or coloured conditions on shallow screens ( Black/White or 4 shades) invariably coloured the whole  
chart area black with nothing showing through. This was so ridiculous that users with such screens can no longer use textures, backgrounds, or  
coloured conditions.

• Saving a report after a Mass Comparison will reveal a progress dialog to let you know what is going on, and there’s also one when you  
save a list from the Search dialog.

• Search Parameters window no longer flickers when it is opened.
• Favourite Charts Menu module totally rewritten:

◊ Maximum number of charts that can be stored, increases from 64 to 5000.
◊ Multiple charts can be added to the menu.
◊ The entries can be sorted by date or by name, ascending or descending.
◊ The dates shown in the menu can now be in one of three formats, or can be hidden.
◊ You can now clear the list completely in addition to the ‘Edit…’ window’s ability to remove one entry at a time.
◊ The list of entries shown in the editing window can be saved as a text file by clicking on the top-right icon button.
◊ Greater code efficiency.

• Upon opening Biorhythms 5.1c for the first time, if you have any Favourite Menu entries from the older format, they will be completely 
converted to the new format, and the older versions will be deleted.

• When the Preferences window is closed, the Favourites menu will only be updated if its date format was changed.

Version   5.04c   (July 1995)  
• Much of the code has been made safer and more resistant to crashes and damaged data.
• Spinning cursors have been greatly improved by yours truly, and the routines should be much safer too.
• ColourCDEF has been improved to version 2.02, and Colour Information too in order to show rgb-based white as real white on B/W 

screens.
• Fixed a bug which meant that double-clicking/drag&dropping a chart then attempting to reopen it with ‘Open last chart’ would fail.
• Fixed small problems when switching control highlighting or chart line samples on or off, using the Preferences section.
• Customised menu definition functions (MDEFs) improved, prevent menus appearing off screen and thus possible crashes.
• New CDEF improves appearance of Search/Edit Fave Menu dialogs.
• Improved screen depth routines take better advantage of multiple monitors.
• Edit Fave Menu dialog enlarged.
• Customised controls highlight properly, such as with the colour picker controls.
• Compare Charts dialog significantly improved: Favourites menu pops up more logically, settings are now saved between uses, and shared 

days within the three cycles can now be indicated pictorially – intelligent coloured backgrounds!
• Date Calculator greatly improved with a a new, more attractive and simple interface. And a calculation bug fixed as well.
• Fixed a bug that could mean that viewing the Image list would accidentally try to read pictures from other open files, although the error-

protection system would ensure no crash resulted.
• Fave Menu editor dialog can now be zoomed so you can see more entries on screen, other visual improvements.
• Now the Search window can be zoomed as well.
• Double clicking the Help file will now open the Help window, just like you’d chosen it from the Apple menu. Similarly double clicking  

the texture file opens the Texture Info window; and with the Preferences file the Preferences dialog will appear. Isn’t that clever! 

Version   5.03c   (June 1995)  
• List positioning improved in ‘Help’, ‘Chart Summary’ and ‘Grouped Summary’ – better looking now.
• ‘Chart compare…’ window now fully resizeable.
• The ‘Windows’ menu now sorts chart windows in the order in which they were created, and utility windows are sorted too. Much more  

professional!
• Bug fixed which meant that when dealing with very large chart images, the picture’s size would be appear to be drastically wrong [Tech:  

moved from (*pic)->picSize to GetHandleSize(pic) ].
• Window zooming handled better, windows won’t be expanded beyond their maximum width. Fixed bug with the zooming of Summary 

windows.
• Fixed two visual imperfections with ‘Chart compare…’.
• Grouped Summary now sorts charts like the Window menu. As a result it doesn’t need to be redrawn as much, and so works much more 

smoothly!
• ‘Search’ now displays the title of the chart it’s searching (always the top-most chart).
• FaveLDEF updated from v2.0.1 to v2.1 (checkbox now has a white background).
• Bug fixed that had meant pressing return in Search or Schedule window would perform the required operation. Twice. All fixed now!
• ‘Search’: flicker greatly reduced in normal speed mode. Introduction of option that will stop you interrupting a search operation, but with  

the result that speed is increased by around 50-150%.
• ‘Chart Summary’: unnecessary redrawing reduced.
• ‘Help’: scrolling is now slightly more ‘intelligent’ than before.
• ‘Mass Compare…’ used to be limited to only 30 charts, but now you can use as many as memory will permit (100 charts will use only 

28.4k of memory!).



• The code that lets you move items in the ‘Favourite Chart Menu Editor’ has been totally replaced because dragging too quickly could  
cause odd things to happen and the list to be jumbled up. Now, click on an entry until the movement cursor appears and drag the grey line  
where you want the entry to be moved to. Release the mouse and it will be moved.

• Big overhaul of printing code – stupid errors and bugs before, but OK now. Now has a proper printing progress dialog.
• Now lets you register your copy of the program (to eliminate shareware messages and more) by entering the registration code (which I  

send you when you send me the shareware fee).
• Version info/Title image updated to 5.03c
• Now uses extended version 2 pictures.
• Two huge and long-standing memory leaks involving textures totally eradicated. Excellent!
• Changing the chart window size from the Edit menu could cause the chart to disappear off screen if its size was greatly reduced. This  

should now be a thing of the past.
• File errors should now reveal slightly more helpful error messages rather than before, when general corruption/damage was reported and  

the program would quit.
• When saving a file and choosing to replace an old one, what used to happen was the old file was deleted and a new one created. Now, the 

old file is updated. This is much better.
• Chart Summary text report: fixed bug and made it look a bit better too. It uses tabs to make it look good with a wordprocessor.
• Unnecessary chart redrawing reduced further.
• Windows menu: utility windows (not charts) are now sorted alphabetically, rather than by their internal reference number.
• Fixed small bugs with Chart Summary and with Calendar drawing.
• Fixed problem whereby when opening a number of charts simultaneously, they would tend to interfere with the drawing of the one before 

them or the one after. Fine now.

Here are some additional changes to version 5.03c, after release. The version number did not change however.

• Fixed a bug with ‘Edit: Window Size…’ which could interfere with the chart window.
• Greatly improved folder chooser, now based upon Apple’s recommended design.
• Better looking way of choosing line widths, with a custom menu and control definition. Maximum width increased from 8 pixels to 10  

pixels.
• Virtually destroyed all trace of flicker with the new version (v4.1) of my date control definition function (the little date boxes you click 

on).
• My proper e-mail address is now shown in the About box.
• Lots of out-of-date code replaced.
• Minor bugs fixed.
• A new chart file format was introduced which allows much greater expandability in future. However, this need not worry you as 5.03c  

will be able to open both types of chart, old and new, no problem at all. The change should hardly be noticeable. Charts will always be saved  
using the new format.

Version   5.02c   (26th May 1995)  
• Spinning cursors have been introduced, with help from Philippe Casgrain.
• Fixed a bug with window activation.
• Fixed a bug with the Colour Scheme submenu.
• Fixed two slight problems that occurred when you display a year’s worth of cycles.
• Restored ‘Chart Summary…’s grow box.
• Reduced flicker in the bit where you track the date and conditions by moving the magnifying glass.
• Introduced ‘Biorhythms Calendars’ – really nice!
• Fixed a huge memory leak with the Calendars and allowed copying of the image to the clipboard.
• At last fixed the problem that caused some white areas to become black when switching from 16/256 colours to 4 colours/Black and  

White.
• Can now copy a monthly calendar as text to the clipboard – fixed a bug with January.
• Fixed some bugs with the Chart-Calendar ‘hot link’.

Version   5.01c   (14th May 1995)  
• ‘Macintosh Information’ gives information about the current system version, the current bit depth of your screen, and the amount of  

memory free.
• ‘Help’ has been reorganised, splitting it into convenient pieces making it both more convenient to use, and quicker too. And its been  

added to as well.
• ‘Look for phase…’ is new, putting an almost impossible calculation within your grasp, for example, on what days will your physical  

cycle be on day 17, emotional on 11, and intellectual on 5? Try doing that on your calculator!
• Can now handle dates from 1st Jan 1600 to 31st Dec 3000. The previous version could only do 1904 to 2039.
• The Date control definition function (the dates you click on) has been upgraded – holding down SHIFT will change values by 10,  

OPTION by 20, COMMAND by 50, also drawing is quicker and better.



• ‘Group Summary’: looks much nicer.
• Substantial changes to ‘Favourite Chart Menu Editor’: looks much nicer, bugs fixed. Instead of exactly 16 charts, you can now have any  

number up to 64.
• Favourite Charts now has its own menu for easier access, and all options have been moved here. Hopefully, the menu is now easier to  

read too.
• You can now move items in the ‘Favourite Chart Menu Editor’: click the one you want to move, and drag it into the right place. (This  

took ages to write, and contains my first bit of assembler). One more memory leak plugged, the other reduced.
• Custom list definition functions improved all round: work better, look better, and handle memory better.
• Optional Phase Indicators in chart windows: +, C, and - icons to make the chart icon clearer.
• Chart saving (and closing) logic improved (considerably!).
• Enabling and disabling of controls better – now won’t do the same thing twice in a row!
• ‘Date Information’ slightly expanded.
• Fixed similar date problems with date control and ‘Date Calculator’.
• ‘Hall of Fame’ slightly expanded.
• Greatly improved handling of chart clicks: clicking in the chart, or on the shortcut buttons.
• Moving from the ‘Summary’ window to a chart used to update the summary *4 times* in a row. Now it’s only twice – a very noticeable  

improvement!
• Fixed bug that made the colour palette menus inaccessible.
• Fixed bug that set the wrong default condition colours.
• Fixed problem that caused images to be drawn at the wrong size.
• Only updates interpretation when it has actually changed (seems obvious really!).
• Fixed a problem that stopped you creating new charts after one has been saved, and a subsequent memory leak.
• Fixed two memory leaks with the chart key images (top right of chart windows).
• Fixed memory leaks with interpretation strings.
• Chart files improved, and an extra 20 more!

Just as I was about to release it on Friday, May 5, I noticed some problems, which I promptly fixed, and then made a few (!!)  
more changes (chronological):

• Fixed stupid mistake that might cause Condition Colours Editor to crash
• Popup colour picker no longer flickers, nor does the coloured tile in ‘Colour Info’
• ‘Hall of Fame’ menu now called ‘Images’ for reasons given below
• Will now shrink the menubar so that all the menus can fit on smaller screens (<14 inch) as much as possible:

◊ ‘Favourites’ shrinks to ‘Faves’
◊ ‘Windows’ shrinks to ‘Docs’

• Corrected a problem when a chart supposed to use a texture is opened when none are available
• Corrected the minimum chart width value
• Properly selects the name of the chart you import into the Favourite Menu Editor
• You can only rearrange items Favourite Menu Editor when there is more than one item (seems obvious!)
• Now stores the current Help section in the Preferences file
• You can now zoom the Help window
• You can now select the Help text and copy parts of it to the clipboard
• Seriously cleaned up the code
• Memory handled even more efficiently – disposes old toolbars when new ones are created.
• Fixed another problem with shortcut buttons (again)
• The colour picker control now has a title which is hilited when colours shown. Great!
• Scheme Editor now smaller and quicker as a result of above
• You can now edit the colours used in chart comparisons
• ‘Compare charts…’ now uses the main palette rather than its own, saving disk space.
• At last! Solved the problem whereby Command-V would paste TWO copies of the same text, whereas choosing the ‘Paste’ 

command would (correctly) just do it once. Command-V now just does it once!
• 5.01c now records your ‘Page Setup…’ information in the Preferences file.
• Totally reorganised ‘Preferences…’, maintaining the 5.01c ‘look and feel’
• You can now choose any texture file you like rather than the standard ‘Biorhythms Preferences’
• 5.01c will no longer crash when it encounters compressed textures (phew!).
• Minor improvement in ‘Texture Information…’
• Fixed two problems with ‘Smart’ Summary.
• Fixed a problem with ‘Chart Summary…’ and window activation
• Can print multiple copies of a window.

Version   5.0c   (9th April 1995)  
• A complete rewrite of the grossly inefficient version 4.5 (July 1993) which was written in Basic (and it showed).



---------------------------------------------
© Andrew Regan, Friday, March 15, 1996
Please register!

Any comments or bugs, please tell me!!!

Andrew_G.D._Regan@iconex.mactel.org (Recommended)
ecuue@csv.warwick.ac.uk (Only during the Academic Year)
101636.547@compuserve.com


